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<H1> Headline
<H2> Headline

<H3> Headline

<H4> Headline

<P> Paragraph

Web Accessibility Guidelines
The latest Stanford Medicine format makes use of several accessibility best practices built into the structure of every
document. Web Authors also have an important role and responsibility regarding the accessibility of their sites.

The easy stuff - Just do it

1. Images

Make sure EVERY foreground graphic has an ALT tag, even shim or blank pixels, which should have alt=" "
(space) for optimum text-only reading
Describe function over appearance; example: "Go to Home Page" for a linked image rather than "Image of
House"
Provide longer descriptions (and transcripts, if applicable) of any animation, video or detailed graphic, such as a
chart
If you use image maps, make sure the hotspots have ALT info, as well as the base graphic

2. Color: Don't ever depend on color alone to convey information; colorblindness is a common disability

3. Links: Preserve link context: Avoid "Click Here." It's much easier for people who use non-graphical browsers to
use links where the link text makes clear what is linked to. Example:
Bad: "We published a report on our research. Click here to see it." 
Good: "You can read the published research report."
Also good: "Research Report - A publication about our research

4. Text:

Use Heading 1 through Heading 6 to create headlines that structure your
document; styled text alone lacks context for text readers and robots
Only one Heading 1 per page
Most of your text should be normal, unstyled text; use the built-in
stylesheet to style text

5. Scripts (JavaScript), applets and plug-ins: Not everyone has or can
use them. If the scripts or embedded objects conatain important
information or navigation, try to provide NOSCRIPT, NOEMBED
alternate content. 

Wherever a <script></script> tag set is used (usually JavaScript) you
can include HTML content between <noscript></noscript> tags.
Wherever an <embed></embed> tag set is used (Flash or video objects for example), you can include HTML
content between <noembed></nobembed> tags. If the browser has JavaScript and plug-ins for the embedded
objects turned on, the browser ignores what's between the NOSCRIPT or NOEMBED tags. If they are disabled,
the HTML is displayed. It's a good idea to test the function of your pages by using the "Preferences" or "Internet
Options" commands for your browser to temporarily turn off scripts and plug-ins before loading the page.

6. Flashing content: Avoid BLINK text and graphic animation resulting in flashing or blinking effects

7. Redirects and pop-ups: Use them with caution; be careful about assuming how long it will take someone to
read a page; pop-ups and links in new windows can cause confusion, so default to linking within the same
window, or warn users that links are pop-ups



8. Validate your pages using any number of online tools (a few are included below)

More challenging

1. Tables:

Elaborate table layouts can cause confusion for some readers; use with caution
Structure tabular data presented in tables with HEADER tags to distinguish the data categories for columns and
rows

2. Multimedia: Provide synchronized captioning of audio if possible, transcripts if not, descriptions of video.

Further Reading

 » CNet/Builder.com - An excellent introduction to the topic

 » Web Accessibility Initiative - World Wide Web Consortium (W3C); the main source, in excruciating detail

 » Section 508 - Gov. site regarding standards

 » makoa.org - More Links & Resources

 » Web-Creators - Notes & slides from Web-Creators lecture

Validation

WAC3:

Try the WAC3 validator:

                                               
Address:

Character Encoding: (detect automatically)

Document Type: (detect automatically)

Options:
 Show Source  Show Parse Tree
 Show Outline  ...exclude attributes

 

There are many other browser options on the WAC3 Alternative Web Browsing page.

Text-only browsers: You can see a simulated Lynx version of any public URL using Lynx-me

Try Bobby, a general validator

http://builder.cnet.com/webbuilding/pages/Authoring/Accessibility/
http://www.w3.org/WAI/
http://www.section508.gov/
http://www.makoa.org/web-design.htm
http://www.stanford.edu/%7Ecquinn/webcreators/
http://validator.w3.org/
http://www.w3.org/WAI/References/Browsing
http://ugweb.cs.ualberta.ca/~gerald/lynx-me.cgi?url=URL;list
http://www.cast.org/bobby/


Hot to Make Backups of Sites and Pages
We're all familiar with Murphy's Law: If anything can go wrong, it will! You can protect yourself and keep the boss
happy by keeping archives of your work in case of human or computer error. Preparing to make changes with
Dreamweaver* is a good time to think about a backup.

To Back Up a Site

1. Make sure your local directory is up to date by getting all the site files from the server

2. On your Desktop (NOT in Dreamweaver), find and select the folder that contains your local files

3. Make a duplicate of the folder:

Windows - Right-click on the folder and select "Copy;" then right-click again and "Paste"

Macintosh - Highlight the folder then select "Duplicate" from the "File" menu

4. Rename the new folder. Add the date at the end (i.e. "localfolder052710" for the archive of the site as of May
27, 2010)

To Back Up a Page

Get a fresh copy of the page's file from the server with Dreamweaver
In Dreamweaver, right-click (Win) or Ctrl-Click (Mac) on the file's name in the Local view of the Files panel;
find Edit and track to Duplicate
Find "Copy of [your file name]" in the local Files list; rename it to indicate your backup, e.g. "[your file name]-
bkup.html" or "[your file name]052710" for May 27, 2010

* Contribute users have access to "Rollbacks," so backups are not an issue for them



CSS Styles: Basic HTML 
[div#mainheadline with nested h1.nomarginvertical]
 h2 a.link_headline Linked Head, Black Text, No Underline

a.link_nounderline linked text »
a.text_bodysmall link_nounderline linked text goes here » a.link_reverse Link Item »

p - Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Nulla dapibus. Nullam congue. Integer ullamcorper
magna sit amet lorem blandit nonummy. Fusce vestibulum felis nec sapien. Duis aliquam vehicula purus. Morbi urna
metus, molestie ac, rhoncus vel, congue eget, ipsum. Vivamus tempor arcu venenatis nulla.

h2 Proin odio augue, venenatis vitae, malesuada sit amet

h3 Aliquam malesuada tortor nec dui. Sed malesuada, ante quis

h4 - Phasellus elementum, velit sed egestas lacinia, velit nisl convallis

h5 - Phasellus commodo, nibh sed dignissim ultrices, tellus massa posuere sapien

h6 - Nunc eget massa ed massa urna, scelerisque nec, placerat iaculis, feugiat dictum

h3.nomarginbottom - Aliquam malesuada tortor nec dui

p.nomargintop - Suspendisse euismod, mauris ac viverra scelerisque, magna lorem aliquam purus, ut malesuada turpis
arcu quis nisl. Suspendisse ante tortor, sagittis id, facilisis sed, scelerisque nec, dolor.

p.nomarginbottom - Cras non turpis id est molestie dapibus. Aliquam adipiscing eros sit amet.

h3.nomarginvertical - Aliquam malesuada tortor nec dui

p.nomargintop - Etiam lobortis fermentum nulla.Nam nec nulla. Donec risus diam, molestie ut, ultrices non, ultrices
non, nibh. In ac sapien.

span.text_leadinheadline Praesent sagittis: Donec et risus. Lorem ipsum dolor sit amet, consectetuer adipiscing elit.
Morbi odio enim, pulvinar vitae, pretium ut, sodales at, enim. Suspendisse euismod, mauris ac viverra scelerisque,
magna lorem aliquam purus, ut malesuada turpis arcu quis nisl.

Default <hr> (above) has been re-defined to make it 1px, flat, and SoM Rule Grey

ul - Default is alt text, slightly smaller than normal body text. Suspendisse ante tortor, sagittis id, facilisis sed,
scelerisque nec, dolor. Links show no underline.
Cras non turpis id est molestie dapibus.
Aliquam adipiscing eros sit amet nulla. Nam nec nulla.



With <p> Proin odio augue, venenatis vitae, malesuada sit amet

With <p>Suspendisse euismod, mauris ac viverra scelerisque, magna lorem aliquam purus, ut malesuada turpis
arcu quis nisl.

With <p> Etiam lobortis fermentum nulla. Nam nec nulla. Donec risus diam, molestie ut, ultrices non, ultrices
non, nibh. In ac sapien.

li.text_bodynormal - Apply a class to each list item <li> element (not the <ul>) to modify the default text style.
li.text_bodylarge - Cras non turpis id est molestie dapibus.
li.text_alert - Aliquam adipiscing eros sit amet nulla. Nam nec nulla.
li.text_allcaps - Aliquam adipiscing eros sit amet nulla. Nam nec nulla.
p.text_bodynormal - Apply a class to a paragraph <p> tag to change the text without changing the list item
bullet.

p.text_bodytiny - With <p> Suspendisse euismod, mauris ac viverra scelerisque, magna lorem aliquam purus, ut
malesuada turpis arcu quis nisl.

p.text_highlight - With <p> Etiam lobortis fermentum nulla. Nam nec nulla. Donec risus diam, molestie ut,
ultrices non, ultrices non, nibh. In ac sapien.

1. ol - Default is alt text, slightly smaller than normal body text. Donec risus diam, molestie ut, ultrices non,
ultrices non, nibh. In ac sapien. Links show underline.

2. Etiam lobortis fermentum nulla.
3. Cum sociis natoque penatibus et magnis dis parturient montes, nascetur ridiculus mus.

4. With <p> Proin odio augue, venenatis vitae, malesuada sit amet

5. With <p>Suspendisse euismod, mauris ac viverra scelerisque, magna lorem aliquam purus, ut malesuada turpis
arcu quis nisl.

6. With <p> Etiam lobortis fermentum nulla. Nam nec nulla. Donec risus diam, molestie ut, ultrices non, ultrices
non, nibh. In ac sapien.

1. li.text_bodynormal - Apply a class to each list item <li> element (not the <ul>) to modify the default text style.
Suspendisse ante tortor, sagittis id, facilisis sed, scelerisque nec, dolor.

2. li.text_bodylarge - Cras non turpis id est molestie dapibus.
3. li.text_alert - Aliquam adipiscing eros sit amet nulla. Nam nec nulla.
4. li.text_allcaps - Aliquam adipiscing eros sit amet nulla. Nam nec nulla.

5. p.text_bodynormal - Apply a class to a paragraph <p> tag to change the text without changing the list item
number.

6. p.text_bodytiny - With <p> Suspendisse euismod, mauris ac viverra scelerisque, magna lorem aliquam purus, ut
malesuada turpis arcu quis nisl.

7. p.text_highlight - With <p> Etiam lobortis fermentum nulla. Nam nec nulla. Donec risus diam, molestie ut,
ultrices non, ultrices non, nibh. In ac sapien.

<blockquote> Sed in ligula. Maecenas iaculis, justo vel pellentesque blandit, lectus nunc aliquet sapien,
quis euismod urna nisl vitae pede. Praesent sagittis. Donec et risus. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit. Morbi odio enim, pulvinar vitae, pretium ut, sodales at, enim.

<blockquote><p> Sed in ligula. Maecenas iaculis, justo vel pellentesque blandit, lectus nunc aliquet



sapien, quis euismod urna nisl vitae pede. Praesent sagittis. Donec et risus. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit. Morbi odio enim, pulvinar vitae, pretium ut, sodales at, enim.

p.text_alert - Vestibulum at turpis. Nunc laoreet ante ut nunc. Aliquam et tortor quis risus molestie tristique. Proin
blandit arcu non urna. Duis nunc lectus, lobortis nec, eleifend sit amet, pharetra a, erat.

p.text_allcaps - Vestibulum at turpis. Nunc laoreet ante ut nunc. Aliquam et tortor quis risus molestie tristique. Proin
blandit arcu non urna. Duis nunc lectus, lobortis nec, eleifend sit amet, pharetra a, erat.

p.text_altfont - Vestibulum at turpis. Nunc laoreet ante ut nunc. Aliquam et tortor quis risus molestie tristique. Proin
blandit arcu non urna. Duis nunc lectus, lobortis nec, eleifend sit amet, pharetra a, erat.

p.text_bodylarge - Nam nisl pede, convallis ac, scelerisque eget, porta et, tellus. In leo augue, sagittis sed, cursus ut,
rhoncus sit amet, dui. Fusce arcu augue, rutrum id, dictum eu, vehicula vel, dolor.

p.text_bodynormal - Phasellus arcu. Donec id enim eget mauris condimentum congue. Maecenas non dui. Fusce quis
velit sit amet ante ultrices mattis. Sed id nibh. Nulla ut velit id urna cursus imperdiet. Vivamus libero. Cras porttitor
tempus ipsum. Ut elit.

p.text_bodymedium - Phasellus arcu. Donec id enim eget mauris condimentum congue. Maecenas non dui. Fusce quis
velit sit amet ante ultrices mattis. Sed id nibh. Nulla ut velit id urna cursus imperdiet. Vivamus libero. Cras porttitor
tempus ipsum. Ut elit.

p.text_bodysmall - Nunc laoreet justo tempor metus. Etiam lectus. Lorem ipsum dolor sit amet, consectetuer adipiscing
elit. Nulla dapibus. Nullam congue. Integer ullamcorper magna sit amet lorem blandit nonummy. Fusce vestibulum
felis nec sapien.

p.text_bodytiny - Duis aliquam vehicula purus. Morbi urna metus, molestie ac, rhoncus vel, congue eget, ipsum.
Vivamus tempor arcu venenatis nulla. Proin odio augue, venenatis vitae, malesuada sit amet, feugiat sed, nisl. Quisque
accumsan mauris sit amet ligula. Nullam in sapien vel lectus semper mattis. Donec consequat luctus velit. Curabitur
porta.

p.text_bold - Fusce ipsum purus, lobortis nec, blandit blandit, scelerisque vitae, velit. Suspendisse nec orci. Aliquam
malesuada tortor nec dui. Sed malesuada, ante quis semper feugiat, dui dui nonummy magna, quis fringilla ipsum nibh
vitae ipsum.

p.text_caption - Vivamus ut nulla vel mi dictum hendrerit. Ut interdum diam id sem. Maecenas elementum cursus
pede. Aenean suscipit sem quis tellus posuere sagittis. Sed eleifend leo eget risus. Phasellus elementum, velit sed
egestas lacinia, velit nisl convallis velit, at lobortis quam lacus ut eros. Nulla pede.

p.text_highlight - Vivamus ut nulla vel mi dictum hendrerit. Ut interdum diam id sem. Maecenas elementum cursus
pede. Aenean suscipit sem quis tellus posuere sagittis. Sed eleifend leo eget risus. Phasellus elementum, velit sed
egestas lacinia.

p.text_italic - Vivamus ut nulla vel mi dictum hendrerit. Ut interdum diam id sem. Maecenas elementum cursus pede.
Aenean suscipit sem quis tellus posuere sagittis. Sed eleifend leo eget risus. Phasellus elementum, velit sed egestas
lacinia.

p.text_leadinheadline - Vivamus ut nulla vel mi dictum hendrerit. Ut interdum diam id sem. Maecenas elementum
cursus pede.

p.text_reverse - for text that overlays dark colors



p.text_quote - Nullam fermentum mauris. Etiam malesuada ante hendrerit neque. Integer vel sapien a erat lobortis
molestie. Nullam elit elit, scelerisque at, euismod eget, tincidunt sed, pede. Pellentesque tellus enim, semper id,
volutpat in, pulvinar eget, nulla. Phasellus commodo, nibh sed dignissim ultrices, tellus massa posuere sapien, quis
suscipit eros nunc ac libero.

p.text_spacehoriz - Aliquam tempor, risus a dictum placerat, urna ante aliquet erat, et pulvinar sem nisi at lacus. Ut
nonummy, diam vel luctus pulvinar, dolor enim volutpat justo, in blandit leo nisl et nisi. Nunc eget massa. S

p.text_spacenone - ed massa urna, scelerisque nec, placerat iaculis, feugiat dictum, magna. Nulla feugiat. Mauris
tristique nibh ut velit. Integer congue ipsum nec sem. Suspendisse dapibus gravida risus. Mauris elementum neque
quis ante. Morbi sagittis varius magna.

p.text_spacevert (adds back standard 150% line-height) - Sed in ligula. Maecenas iaculis, justo vel pellentesque
blandit, lectus nunc aliquet sapien, quis euismod urna nisl vitae pede. Praesent sagittis. Donec et risus. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit. Morbi odio enim, pulvinar vitae, pretium ut, sodales at, enim.

Tables and vertical spacing

table - h1 through h6 and p - nested in table - inserts extra
vertical space in most browsers

p all such elements have extra vertical spacing, above and below

Table with table_nobreaks CSS modifier to remove vertical spacing

table.table_nobreaks - removes vertical margins from h1
through h6 and p

p note: removes from all such elements, whether wanted or not. Spacing can be added back in with
other controls

Table with CSS margin modifiers on nested elements

table h2.nomargintop - removes top margin from this block
element only

p.nomarginbottom - each element must be classed individually to remove or add vertical spacing where
needed.



Table with table_standard modifier to add background colors

<th>s get a tan background, bold text Ipsum Factum
table.table_standard creates automatic styling of
headings (<th>) and table background. The weight
of the cell border rules is determined by setting the
cellspacing of the table.

Vertical
alignment within
the cell is also
set by the user.

sismodignit
atum

h4 and other block-level elements insert extra
spacing volore molore

Table with table_standard AND table_nobreaks modifiers

Lorem Ipsum Factum

p table.table_standard table_nobreaks - combining
both styles creates the background layout effect and
removes all vertical spacing.

valign
top p Lor senisl illut lor irit wis nim dolobore dipis dignis

accum nos augiat. Ut wisl ea feu facil ipsuscip er irit aut
nonumsan utpate consecte mincinisi.

et vel volore
h4 Lore consecte molumsa

p Digna adipit ullaore aesecte venit prat. Duip eui te mod
modigna adignisl in ulputatue dolor ing eugait, sim
zzriuscing elessequat, quis digniamet.

Jason
Cross-Out



Clear the Browser's Cache
As you browse Web pages, your browser makes local copies of the data associated with those Web pages, to make the
browser more responsive by saving download time for data that is cached. Sometimes, this can interfere with a
developer's ability to see work changes, to Web pages, slide shows and other elements embeded in Web pages, and to
Web applications. After clearing the browser cached, it must re-download the resource, ensuring you see the latest
version.

Wikihow maintains a detailed list of instructions for clearing the cache of various browsers:

http://www.wikihow.com/Clear-Your-Browser's-Cache


Troubleshooting: Common Connection Problems
Here are the most common problems, in order of frequency among users. Please read each carefully. If one doesn't
help, try the next. If none get you connected, use the link to Web Help at the end.

#1 Problem: Don't know the connection URL

You should have received the connection URL for your site when your access was established. The URL always
begins with “https://irt-publish.stanford.edu/live/" The "s" in "https" (for "secure") is important, and you can't connect
without it. If you know your URL under the med.stanford.edu domain, you can decipher the rest of the Web DAV for
yourself. If your URI is med.stanford.edu/path/to/yoursite/ or yoursite.stanford.edu, then your connection URL is
probably http://irt-publish.stanford.edu/live/path/to/yoursite/

#2 Problem: Firewall

Network firewalls can interfere with connections to Luge. The VA Palo Alto facility has such a firewall. If you work at
the VA and are having trouble connecting, configure Dreamweaver normally and email Evelyn Willcox -
Evelyn.Willcox@med.va.gov - and CC Larry Vellinga - LARRY.VELLINGA@med.va.gov - with the following
information:

Your name
Why you need access, i.e. "access to the site at http://yourURLgoesHere/"
Your computer's ID, which looks similar to this: "abcdefwxyz/pal-p4c236w2.v21.med.va.gov"

Evelyn or Larry will let you know when to re-try your connection.

#3 Problem: Server down

Occasionally, the IRT server is off-line. When this is a planned action, typically for servicing, IRT tries to provide
advance notice and do the work during days and times with the least likely impact on operations. Sometimes, the
server fails as any technology will, and IRT tries to avoid these and keep them brief when they happen. If you can
view the site through your browser, you should be able to access the server through WebDAV. If
http://med.stanford.edu/ is not available in your browser during normal business hours, please immediately call the IRT
Help Desk line, (650) 723-8000 and use option 6 to report the outage.

#4 Problem: WebDAV Error (sometimes with "sharing violation")

Bill Gates doesn't like to share. Make sure your Office documents (word, excel, etc) are closed when you try to put
them to the server.

You may also want to review the procedure for setting up your connection, in the online Dreamweaver training, and
the Troubleshooting page also.

If you are still having trouble, contact Web Help for further assistance.

 



Add Downloadable Documents
Certain common documents, such as Microsoft Word (.doc), Excel (.xls) and Powerpoint (.ppt), as well as Acrobat
(.pdf), can be added to your site as downloadable files. The user must have the appropriate editing or viewing software
to make use of such documents. 

Step 1: Make the file ready for the Web

1. All files used in Web sites, including downloadable documents, should avoid spaces and special characters in the
file name

2. If working with your own document, examine the file on your computer's desktop
Re-name the file to remove any spaces or special characters
You can use dashes (-) or underscores (_) instead of spaces
The file must have the correct extension, e.g. ".doc" for Word documents or ".pdf" for Acrobat documents

Step 2: Place document within local site files

1. Still on your computer's desktop, find and open your site's local folder
2. Look for a folder at the site's root named "files" or "documents" or perhaps "secure"; if you don't find one of

these, create a new folder named "documents"
3. Move your sample document into this folder

Step 3: Upload file and link to it

1. Switch to Dreamweaver; you may want to right/ctrl-click on the list of files and select "Refresh Local Files" to
update the list

2. Find an open the "documents" folder by double-clicking on it
3. Select the document within and click the Put button in the files panel
4. Open the page you want to link from, e.g. my_project/index.html or root/my_page.html
5. Create a new link to the file the same way you would if linking to a page, i.e. using the Browse button or the

Point to File button
Because the user must have appropriate software, it is customary to warn them in the link text that the link
is to a downloadable file, e.g. "Application Form (PDF)"

6. Save, Put and switch to the browser to reload and validate by clicking the link

Important note

The version of the document linked from the Web page is completely independent of the original file. Any changes
you make to your document on your computer will not be reflected in the online version unless you either:

1. Upload the edited document under the exact same file name, overwriting the original, OR
2. Upload a new edited version under a new file name, and re-link





Edit an Existing Page

Step 1: Identify a page (and file) to edit

1. Locate the page you want to edit in a browser. This will be somewhere within the site you got access to as a
requirement for completing the training. Students, be sure you are viewing your specific student site. 
Example: http://medwebtraining.stanford.edu/practice/student6/education/

2. Examine the URL in the Address bar; the URL will tell you where to look for the file in your site
The URL shows you the file's name and what folder it lives in
http://yoursite.stanford.edu/2col_stationery.html 
OR http://med.stanford.edu/yoursite/2col_stationery.html 
This file would be "2col_stationery.html,"at the top level of the local directory
http://yoursite.stanford.edu/education/fellowships.html
This file would be "fellowships.html," within the "education" directory
http://yoursite.stanford.edu/education/
This file would be "index.html," within the "education" directory; a URL that ends in a slash calls to the
index.html file

3. Switch to Dreamweaver and find the file in question within your local site files directory. Students, find the
index.html file in the education folder.

Step 2: Get a fresh copy from the server

1. Connect to the server, if not already connected

2. Select the file for the page you wish to edit; it doesn't matter whether you do this in the "Local View" or the
"Remote View."

3. Click the "Get" button (or, use the Check-out command, if using Check-in/Check-out); click "Yes" when
prompted about "Dependent files."

Step 3: Edit the page

1. Open the page file by double-clicking on the file name in the "Local View"
2. Note the editable and non-editable regions of the page.

When you pass your cursor over locked regions of the page, it looks like this: 
Editable areas are marked by green tabs with names
BreadCrumbs and LeftColumn editable areas contain server-side includes and aren't generally edited on
pages; these will be explained in a later tutorial
Other editable areas (MainColumn, CenterColumn and RightColumn) are for body text; edit freely in these
areas

3. Make whatever text or other changes are desired; for this exercise you can just update the main headline

4. Save the changes using the menu sequence File > Save

Step 4: Put

Put the edited page to the server, either using the "File Management" button/menu at the top of the page



document window, or by selecting the file by name from the Local View list and clicking the "Put" button.
Dependent Files: You can click "No" when prompted about dependents

Step 5: Validate

Always confirm page changes in your browser by switching to the browser and reloading your view of the page
you have changed. Test any new links you have added to the page. Continue making changes in Dreamweaver,
putting the page to the server, and checking the page in your browser, until you are satisfied.



How to Use Dreamweaver to Find Your Local Files
Launch Dreamweaver
In Dreamweaver's main menu click Site > Manage Sites...
In the resulting window, you will need to edit every site you work with. Most authors only manage one site

Select the site you would like to edit and click the "Edit..." button on the right
In the resulting window make sure that the "Advanced" tab at the top of the window is selected and in the
"Category" pane on the left side "Local Info" should be selected
Click on the yellow folder icon (  ) to the right of the "Local root folder" field
In the resulting window expand the drop-down menu next to "Select:" as illustrated below

Select Field

This will show you where your site files are located on your computer. Remember this location as you will be
moving/deleting files here in the next steps
Close all Dreamweaver windows that are currently open without closing the application

Click "Cancel" in the "Choose local root folder for site…" window
Click "Cancel" in the "Site Definition for…" window
Click “Done” in the "Manage Sites" window

Minimize Dreamweaver and go to the location on your computer that you keep your site files. This is the
location that you found under "Local Info" in the step above

 



Include Dependent files?

Get and Put Files

Get Before You Edit

To be sure you are editing the current live content of a page, and not some old copy of the page, each time you edit a
page, "Get" it fresh from the server.

1. Select a file from your files list; you can select the file in either Remote or Local views
2. Click the "Get" button

"Get" always copies the file from the server to the local folder, overwriting the local version of the file, no
matter which view it was selected under

3. Click "Yes" when prompted about Dependent files (more about this below)
4. You now have a fresh copy of the file to edit

NOTE: Double-clicking on a file on the Remote list copies the file to Local and then opens the Local copy of the file.

Put = Publish (sort of)

After editing a file, you will "Put" it to publish it and make it available on the server. "Sort of" means that it's not truly
"live" until there is a link to it from somewhere. However anyone you email the URL to can view the page now.

1. Select a file from your files list; you can select the file in either Remote or Local views
2. Click the "Put" button

"Put" always copies the file from the local folder to the server, overwriting the remote version of the
file, no matter which view it was selected under

3. You can click "Yes" or "No" on the Dependent files prompt (more about this below)
4. The edited file is available in the browser and can be found by users if:

The page is linked to from another page, OR
You provide the URL to users, say by email

About dependent files

Dependent files include images on your Web page, server-side include
files, anything else the browser needs to assemble the page.
In general, click "Yes" on "Get" and "No" on "Put," but don't forget
to "Put" any new images used on the page individually.

Reviewing your work on the Web

Validate: Always check changes in your browser, looking for broken images and links and any other problems
with the page.
Refresh: The browser shows a snapshot of the page's state when it was last called. Changes won't appear until
you click the browser's Refresh/Reload button to refresh the browser's view.
Caching: Some browsers cache page views and may be slow to update on refresh. You can usually change the
browser's preferences to prevent caching on reload.



Check-in/Check-out

Because it can lead to problems editing your site when not used properly (and sometimes even when it is used
properly) IRT recommends you not use Check-in/Check-out unless you know you really, really need it. Instead, we
recommend that all Dreamweaver Web Authors adopt the best-practice of "getting" a fresh copy of each file to be
edited from the server before editing. This avoids the problem Check-in/Check-out addresses 99.9% of the time.

If you decide to use Check-in/Check-out

When sites have multiple authors, they risk overwriting each other's changes if they don't get fresh copies of files
from the server and coordinate their changes. Check-in/Check-out is a control method to mechanically prevent
users overwriting each other's changes.
To engage Check-in/Check-out, select the radio button in the Remote Info category of the site definitions panel
(see Setting Up).
Checking out a file causes it to be locked on the server, so other authors can't open it. Dreamweaver displays a
checkmark next to checked out files.
If using this method, substitute "Check-out" for "Get" and "Check-in" for "Put" wherever they occur in this
training. It's important that you not forget to Check-in your files, or they will remain locked to other
authors, and to yourself on other computers, until they are checked back in.
Dreamweaver typically locks Checked-in files . Right-click selected files and choose "Unlock" or "Undo Read
Only" to unlock files for editing.

How to remove Check-in/Check-out

Important: Before removing the Check-in/Check-out function, make sure all of your site files have been
checked in; all Web Authors using this method on a given site need to follow these instructions

Connect to the site normally; set your Files panel to Normal View or view in the expanded Files panel that
shows both Remote and Local
In the Local view, right-click (Win) or option-click (Mac) on the topmost folder for all of the site's files;
choose "Undo Check Out" from the popup menu
Still in Local panel, right-click (Win) or option-click (Mac) on the topmost folder for all of the site's
files; choose "Turn off Read Only" or "Unlock" from the popup menu
These actions ensure that you don't have any files checked out or locked

Get the Manage Sites command from the Files pull-down, or from the Site menu
Select your site definition and click the Edit button
Select the Remote Info category under the Advanced tab
Uncheck the button for "Enable check in and check out"
All other settings should be fine; click the OK button to exit the site definition
Click the Done button to return to your connection for that site
Proceed with normal publishing

If you are still having problems with permissions associated with Check-in/Check-out, contact Web Help.



Get Your Site Files from the Server
This lesson describes how to download all your website files from the web server to your computer. You must do this
before you can begin editing.

Terms:

GET - When you begin working on a site, you use "Get" to get all the website files from the web server. This
lesson shows you how to download all the website files to your computer.
PUT - As you edit files and create new pages, you use "Put" to put them on the web serverr to publish them.

Steps:

1. Open Dreamweaver.

2. Connect to your Remote Site by clicking on the "Connect" button. 

In the FILES panel, click the drop-down list and select Remote Server as shown:

Remote Server - shows all the files on the web server
Local view - shows all the files on your computer

NOTE: If your website was previously edited with
Contribute, you may receive an alert about Contribute
compatibility; if you do, click "NO." (Contact Web Help if
you think you need Contribute compatibilty).

4. In the Remote Server list, select the top folder. This should
be the home folder for your website.

5. Right-click and select Get as shown here:



6. You will see this message: Are you sure you wish to get the entire site? Click OK.
7. This message displays: Get dependent files? Click No.

Files will begin to download to your computer. Depending on the size of the website, this might take a while. WAIT
until all files have finished downloading. HINT: As long as the "Background Activity" box is still open, the site is still
downloading.

Backup your directory

Now that the website files are on your computer, you might want to make a backup before you start editing. Just copy
the website directory like you would any other directory on your computer. You can do this from Dreamweaver or
from your computer file directory.

Next Step: Set up your Local Templates

If you open any page at this point, it won't look right. That's because you haven't set up your local Templates folder.
The next lesson describes how to do that.



Server-side includes (SSIs)
Server-side includes (SSIs) are a server technology that allows the site developer to maintain frequently used content,
such as navigation bars, headers and footers, in a single file that can be introduced into every page where it's needed.
The IRT server parses every .html page for SSIs, and serves any called for by the code of the page by bringing the
include file's code into the code of the page being served.



Troubleshooting: Common Linking Problems
When a link doesn't work in the browser, it's usually because of one of these common problems:

1. The link is miss-set. Link URLs should match file names/URLs EXACTLY. Letter case matters. Also, be aware
of the link type, i.e. docuement-relative, root-relative or absolute URL (e.g.
http://something.stanford.edu/the/full/path/to/the/page.html)

2. You may find it most effective to use Dreamweaver's built-in link-setting tools, found in the Properties
Inspector. Select the text, then click on the folder icon next to the "Link" field and navigate to the file in your
local site. "Open" and the relative link is set.

3. You put the file with the link, but not the linked file to the server. Go to the URL for the file in question (using
EXACT file name) and confirm that it's on the server. You can also confirm this by looking at your "Remote
Site" pane in the "Site Files" window.

4. Linked file name is malformed: You should not use any spaces or special characters in your file names. So
"something about # 1.html" would be a bad file name, but "something_about_no_1.html" is acceptable. Use
underscores or hyphens if you need to break file names into words. Files must also end with a proper suffix, i.e.
.html, .htm, .pdf, .jpg, .gif, .doc, etc.

5. If you are linking to an external file, on some other site, you must use the full URL, including "http://" or the
link won't work.

For more information on setting links in Dreamweaver, use the Dreamweaver Help menu and select "Using
Dreamweaver" and click on the "Linking and Navigation" item in the list on the left.



Set Up Local Templates
You will need a local copy of the Templates resources for your site in order to preview your pages in Dreamweaver. If
your pages look weird or broken, it's probably because you don't have local Templates resources installed in your local
site folder.

Extract Templates from Templates.zip

1. You should have done a "Get" of your site, copying of all the live files to your computer
2. In your browser, follow one of your site's links to a page or stationery file
3. In Dreamweaver, find and open the same file you viewed in the browser (check the end of the browser URL if

you're not sure of the file's name)
If it looks broken as expected (not at all like the browser view) then you need to extract your local
Templates folder
Close the file

4. Examine your computer's local site folder for a file named Templates.zip; contact Web Help if you do not have
a Templates.zip file or Templates folder on your live site

Windows XP and Vista users: Don't double-click the Templates.zip file to extract it; this creates a
double-nested Templates folder, which breaks it. Instead, do this:

1. Find the Templates.zip file on your desktop
2. Right-click the Templates.zip file; from the pop-up menu, select "Open With" and then

"Compressed (zipped) Folders; this opens the .zip file as if it were a folder
3. Right-click on the Templates folder and find Copy
4. Use the Back button to return to the root of your local site folder
5. Right-click on the white part of the window and select Paste; a Templates folder is pasted into your

local site root
You can get the free Stuffit Expander utility from SmithMicro site:
   Expander for Mac
   Expander for Win
After installing Expander, use it to expand the Templates.zip archive

5. You should end up with a folder named "Templates" at the root of your site's local folder
This Templates folder is only to enable your preview in Dreamweaver
Whether you put it to the site or not will have no effect on your Web pages

6. Return to Dreamweaver and re-open the file you opened in step 3; it should appear much more like the view in
the browser

http://my.smithmicro.com/mac/stuffit/expander.html
http://my.smithmicro.com/win/stuffit/expander.html


Create a New Page

Important: All new pages must be created from an existing functional page in your site. The new page will take on all
the source page's features, so choose the source page carefully. By features, we mean BreadCrumbs, LeftColumn links,
and tab highlight, if any.

Step 1: Identify a page (and file) to duplicate

1. Locate the page you want to duplicate in a browser; for this exercise, find the 2-column stationery page
2. Examine the URL in the Address bar; the URL will tell you where to look for the file in your site, e.g.

root/2col_stationery.html
3. Switch to Dreamweaver, find the file in question within your local site files directory, and open it, as if for

editing
4. Use the menu sequence File > Save As… and give the file a new name. Make sure there are no spaces or

special characters in the file name. You can use hyphens (-) or underscores (_) to make words in your file
names. Keep file names as short as possible. If working on a tutorial, try "my_page.html"

Step 2: Modify your new page, save and put

1. Update the main headline: “This is [your name]'s Page”
2. Update the browser title: “[your name]'s Page”
3. Save the file and then use the menu sequence Site > Put. You can click "No" on the Dependent Files prompt

Step 3: Validate the new page in your browser

1. Switch to the browser window and find your site's home page
2. Look at the Address bar; it either ends "/" or "/index.html"
3. You want "/my_page.html"; if the URL ends in "/" go to the end and type "my_page.html"; if it ends

"index.html" select this and replace it with "my_page.html"
4. Type Enter; you should see your new page

If not, check your URL and file name; they must match exactly, including capitalization
5. You can switch back to Dreamweaver and close the my_page.html file

Filling in your content

In reality, you would fill in all of the page's content -- text, images, charts, etc. -- and upload it to the server to
"publish" it (sort of)
Until the page is linked, it's what we refer to as "Secure by Obscure" in that it can only be found if one is
provided the URL
The edited file is available in the browser and can be found by users if:

The page is linked to from another page, OR
You provide the URL to users, say by email; this is one method of private review before publication



Create a New Topic Subdirectory
Sites are structured with subdirectories within the main, or "root" folder for the site. Subdirectories are a place to store
the pages of a topic and also sub-subdirectories for related sub-topics. As with pages, new subdirectories should be
created by duplicating existing, functional directories.

Step 1: Find a source folder to duplicate

1. In your browser, find a New Subdirectory stationery folder; Student practice sites will have a "New
Subdirectory" link you can follow

2. If working a live site, look for root/new_subdirectory/ (version 2.0) or root/new-subdirectory/ (version 1.9)
You can look at your site files in Dreamweaver or on your desktop for the exact folder name
If your site doesn't have one, you can request installation of via Web Help

3. You can also work with any functional topic folder; remember that everything in your source folder will be
duplicated (you may want to choose the simplest or most like your new topic)

4. Note how a directory listing shows in the browser when there's no index.html

Step 2: Duplicate source folder

1. In Dreamweaver, find and examine the same folder as viewed in the browser
2. Select the source folder and right-click (Win) or Ctrl-click (Mac); find the Edit menu item, then the Duplicate

submenu item
3. A new folder named "Copy of [source folder name]" is created; select it
4. Re-name the folder for your topic

no spaces or special characters!
hyphens (-) and underscores (_) are OK
keep it short; for our example
let's use "my_project"

5. Dreamweaver asks if you want to check for broken links to updated files; click "Don't Update"
6. Examine your new folder

If you used a New Subdirectory stationery folder, you have one or more page stationery files, and an
includes folder, but no home page
If you used a developed topic's folder as your source, you have copies of all that topic's files

you may want to delete all but one page (the simplest) and use it as your new page stationery
you can delete, update or replace the existing index.html home page (see next tutorial); if you want
to save the older version, re-name it "index-old.html"

Step 3: Update links through Find/Replace

1. In Dreamweaver, select the new topic folder you created
2. Use the menu sequence Edit > Find and Replace
3. Check your search settings

Find in: Selected Files in Site
Search: Source Code
Find: [source directory name] e.g. "new_subdirectory" or "new-subdirectory"
Replace: [new topic folder name] e.g. "my_project"
Options: None need to be checked, but note "Match case" and "Ignore whitespace"

4. Click "Replace All" button; Dreamweaver warns you this cannot be undone; click "Yes"



5. Note how results are returned in the results panel; collapse the Result panel

Step 4: Apply topic to stationery

1. In Dreamweaver, open the 2-column stationery file from within your new topic's folder; if your folder already
has an index.html you want to keep, open it as well

2. You will duplicate this file to create all of the new topic's pages, so think about any features you want to appear
on all or most

3. Update the Browser Title to specify the topic, typically the second group words
Example: PageNameHere - TopicNameHere - SiteNameHere - Stanford University School of Medicine

4. Save your changes

Step 5: Create topic home page

1. If you don't still have the stationery file open, open it now
2. File > Save As...
3. Name the file "index.html" - it must be spelled exactly like this
4. Make sure it is inside your new topic folder; if there's already an index.html and you want to replace it, click

Yes when prompted
5. Update the main headline to communicate your topic, e.g. "The [your name] Web Training Project"

Steps 6 & 7: Put new folder to server and validate in a browser

1. Select the new topic folder you created ("my_project") in the Local files list
2. Click the Put button; click "No" on the dependent files prompt
3. Switch to your browser, view the new folder

Browse to your site's home page
The URL ends in either a slash, ("/") or "index.html"
If "index.html," delete back to the slash

Type or paste the new folder name after the slash e.g. /my_project/
Type Enter to access the URL

4. If you have trouble finding the new folder in your browser
Check that it was uploaded and that you have spelled the folder name exactly as in Dreamweaver
You can link from the body of one of your other pages to the folder or it's index.html file and then refresh
the linking page and follow that link in the browser

Fill in the topic's pages later

We will use our new topic folder to learn about Breadcrumbs and Left Navigation links in the following
tutorials. Hold off on creating the individual topic pages for now.
Later, when the Breadcrumbs and Left Navigation links are properly set up, you will create all of the pages for
your topic, following the Create a New Page tutorial
The home page you created from 2-column stationery is typical for most topics, however you can also try
creating a Special Case Design (2.0 only - this is an advanced activity)

file:///C|/Users/Jason/Desktop/IRT%20Archive/body_links.html
http://med.stanford.edu/irt-resources/webauthor/training/dreamweaver/
file:///C|/Users/Jason/Desktop/IRT%20Archive/breadcrumbs.html


Create a New Topic Subdirectory
Sites are structured with subdirectories within the main, or "root" folder for the site. Subdirectories are a place to store
the pages of a topic and also sub-subdirectories for related sub-topics. As with pages, new subdirectories should be
created by duplicating existing, functional directories.

Step 1: Find a source folder to duplicate

1. In your browser, find a New Subdirectory stationery folder; Student practice sites will have a "New
Subdirectory" link you can follow

2. If working a live site, look for root/new_subdirectory/ (version 2.0) or root/new-subdirectory/ (version 1.9)
You can look at your site files in Dreamweaver or on your desktop for the exact folder name
If your site doesn't have one, you can request installation of via Web Help

3. You can also work with any functional topic folder; remember that everything in your source folder will be
duplicated (you may want to choose the simplest or most like your new topic)

4. Note how a directory listing shows in the browser when there's no index.html

Step 2: Duplicate source folder

1. In Dreamweaver, find and examine the same folder as viewed in the browser
2. Select the source folder and right-click (Win) or Ctrl-click (Mac); find the Edit menu item, then the Duplicate

submenu item
3. A new folder named "Copy of [source folder name]" is created; select it
4. Re-name the folder for your topic

no spaces or special characters!
hyphens (-) and underscores (_) are OK
keep it short; for our example
let's use "my_project"

5. Dreamweaver asks if you want to check for broken links to updated files; click "Don't Update"
6. Examine your new folder

If you used a New Subdirectory stationery folder, you have one or more page stationery files, and an
includes folder, but no home page
If you used a developed topic's folder as your source, you have copies of all that topic's files

you may want to delete all but one page (the simplest) and use it as your new page stationery
you can delete, update or replace the existing index.html home page (see next tutorial); if you want
to save the older version, re-name it "index-old.html"

Step 3: Update links through Find/Replace

1. In Dreamweaver, select the new topic folder you created
2. Use the menu sequence Edit > Find and Replace
3. Check your search settings

Find in: Selected Files in Site
Search: Source Code
Find: [source directory name] e.g. "new_subdirectory" or "new-subdirectory"
Replace: [new topic folder name] e.g. "my_project"
Options: None need to be checked, but note "Match case" and "Ignore whitespace"

4. Click "Replace All" button; Dreamweaver warns you this cannot be undone; click "Yes"



5. Note how results are returned in the results panel; collapse the Result panel

Step 4: Apply topic to stationery

1. In Dreamweaver, open the 2-column stationery file from within your new topic's folder; if your folder already
has an index.html you want to keep, open it as well

2. You will duplicate this file to create all of the new topic's pages, so think about any features you want to appear
on all or most

3. Update the Browser Title to specify the topic, typically the second group words
Example: PageNameHere - TopicNameHere - SiteNameHere - Stanford University School of Medicine

4. Save your changes

Step 5: Create topic home page

1. If you don't still have the stationery file open, open it now
2. File > Save As...
3. Name the file "index.html" - it must be spelled exactly like this
4. Make sure it is inside your new topic folder; if there's already an index.html and you want to replace it, click

Yes when prompted
5. Update the main headline to communicate your topic, e.g. "The [your name] Web Training Project"

Steps 6 & 7: Put new folder to server and validate in a browser

1. Select the new topic folder you created ("my_project") in the Local files list
2. Click the Put button; click "No" on the dependent files prompt
3. Switch to your browser, view the new folder

Browse to your site's home page
The URL ends in either a slash, ("/") or "index.html"
If "index.html," delete back to the slash

Type or paste the new folder name after the slash e.g. /my_project/
Type Enter to access the URL

4. If you have trouble finding the new folder in your browser
Check that it was uploaded and that you have spelled the folder name exactly as in Dreamweaver
You can link from the body of one of your other pages to the folder or it's index.html file and then refresh
the linking page and follow that link in the browser

Fill in the topic's pages later

We will use our new topic folder to learn about Breadcrumbs and Left Navigation links in the following
tutorials. Hold off on creating the individual topic pages for now.
Later, when the Breadcrumbs and Left Navigation links are properly set up, you will create all of the pages for
your topic, following the Create a New Page tutorial
The home page you created from 2-column stationery is typical for most topics, however you can also try
creating a Special Case Design (2.0 only - this is an advanced activity)

file:///C|/Users/Jason/Desktop/IRT%20Archive/body_links.html
http://med.stanford.edu/irt-resources/webauthor/training/dreamweaver/
file:///C|/Users/Jason/Desktop/IRT%20Archive/breadcrumbs.html


How to Apply Redirect and De-robot Code
If you use the Web much you've seen the ubiquitous: "404 - Not Found," typically when linking from a search results
page or Web page. It means "It ain't there anymore, if it ever was." Changing locations or URLs is pretty common in
Web development. When moving pages or changing the URL, you should make sure that users who visit the obsolete
URL end up at the page they want and you have.

The most straightforward way to do this is to leave the old page in place and add a redirect meta tag in between the
<head> and </head> tags. Here's code you can copy:

<meta http-equiv="refresh" content="0;URL=xxxxURLgoesHere" />

View Code and replace the entire HTML contents of each file with the meta tag. Change the text "xxxxURLgoesHere"
to the URL of the file you want to redirect to. This can be relative or absolute.

Your page(s) may also be indexed in Stanford Google and other search engines. To test for this, used the Advanced
Search page and paste the page's URL in the "Domains" field. To remove a page from the index, you should apply
another meta tag to de-robot the page:

<meta name="robots" content="noindex, nofollow" />

You can copy and paste each of these chunks of code into your pages individually, and redirect to specific new
locations, or do a Dreamweaver Find and Replace operation to find

</head>

and replace it with

<meta http-equiv="refresh" content="0;URL=xxxxURLgoesHere" /> <meta name="robots"
content="noindex, nofollow" /> </head>

to redirect all pages to the top of the new site.

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 



Adding a search field to your page
New Stanford Medicine sites come with a custom search box in the upper right corner. The following may be useful
for sites outside of the Stanford format, or where other search options are needed.

Using Stanford Search on your site

You can set up a search field to pull results for your site from the Stanford Search index, the one used by the Search
field of the main Stanford Home page. Before adding Search capabilities to your site, it's a good idea to make sure
your pages are set up to produce good results in search engines. Any files you want to be searched should have:

A unique and informative browser title: Each page's browser title should be different from those of other
pages and reflect the content of the page. This is the number 1 factor used to rank pages in most search engines
A description meta-tag (meta-tags are bits of code that are invisible to users but used by browsers and search
engines).
A keyword meta-tag

More detail on setting up for Search can be found on the Information and Instructions for Web Site Creators page.

In order to search your site, it must be listed in the Stanford index. You can test a directory URL using the "Domains"
field on the Advanced Search page. The Google appliance crawls all Stanford domains twice weekly and will index
any site linked from any page in the index. You can request that a domain or directory be added using the HelpSU
web form.

Stanford's Information and Instructions for Web Site Creators page has code you can copy and paste into the code for
your page(s), plus explanations of what all the inputs mean and how to change variables to customize your search.

Or, you can use some code we've modified ourselves.

Sample search boxes

Stanford Medicine collection

The Stanford Google index includes a collection for the Medical Center, that includes all the known, indexed URIs for
Stanford Medicine public Web sites and also the Stanford University Hospital & Clinics and Lucile Packard Children's
Hospital sites. You can test for any specific URI using the Stanford Medicine Advanced Search page. Results are
provided in the standard Stanford Medicine Web format.

Search Stanford Medicine:
 

Here's code you can copy to create this search box:



Searching a specific site or directory

Search A Specific Site (in this example:
med.stanford.edu/education):

 

Here's code you can copy to create this search box:

1. Select and copy the following code:

2. Paste the code into the HTML code for your page, where you want the Search box to appear.

3. Change "med.stanford.edu/education" to the directory-level URL you want to be searched. Note that a final slash
in the URL, i.e. "med.stanford.edu/pathto/yoursite/" will return results from that directory only, not
subdirectories. To include all content within a given site or directory, leave off the final slash, i.e.
"med.stanford.edu/pathto/yoursite" or "yoursite.stanford.edu"

4. To search multiple sites or locations, add additional "site:[URL]" values with a space between, i.e.
<input type='hidden' name='as_oq' value='site:med.stanford.edu/education site:med.stanford.edu/research
site:med.stanford.edu/patient_care'>

5. If your search form appears on a page mounted within a frame or iFrame, you may want to add the code
'target="_top"' to the form tag, i.e.
<form action="http://med.stanford.edu/searchsm/" method="get" target="_top">
to keep the results page (and links forward from it) from being trapped inside the frame. You can also set
'target="_blank"' if you want your results to appear in a new browser window.



Last thought

Other form elements (like radio buttons, check boxes, pull-down menus) can be substituted for hidden fields to create
user-selectable options.



Import Your Site Definition File (CS 5.0 +)
Follow the instructions below to connect to your website. NOTE: Before you can connect to your website, you must
request authorization from IRT by entering a Web Help Request. A SUNet ID is required.

Video Demonstration:

 

Follow these steps:
MORE RESOURCES:

Instructions for Dreamweaver 4.0
Dreamweaver training
Local template info
Hosting Policies
Web Author's Group: Join the SoM Web Authors user group in CAP network
Rrequest Web Help

NOTE: These steps apply to Dreamweaver CS5 and higher. For other Dreamweaver versions, please see this page for
directions: Older Dreamweaver instructions .

Your site definition file (.ste) contains information needed to connect to your site. You will receive an email from
Web Services that contains your site definition file.

1. When you receive the email, save the attached file to your desktop (or somewhere you can find it).

2. Open Dreamweaver.

3. From the Dreamweaver main menu, click "Site" and then select "Manage Sites" as shown below:

manage sites

4. The Manage Sites window displays. Click "Import."

5. Find the file (.ste) you just saved and select it. The Choose Local Root Folder window displays:

6. Navigate to the location where you want to keep all the files for this website. If needed, you can create a new folder



from here. This will be the "Local Root Folder" for this website.

NOTE: If you have worked on a previous version of this website, please select a new local folder location
now. Using Dreamweaver, be sure to "get" a fresh copy of your website files from the server before you
start to edit.

7. When you locate the folder you want, click Select. Dreamweaver will import the site definition file.

8. When the Manage Sites window redisplays, select your website name from the list and click the Edit button as
shown below:

 

9. The Site Setup window displays. In the left menu, click "Servers."

10. Select your server from the list. Double click on it or click the pencil symbol as shown here:

A window similar to this displays:

NOTE: DO NOT change any information already in the fields. This information was entered when you imported the
Site Definition file.

11. In the Username field enter your SUNet ID. In the Password field, enter your SUNet password as shown below.

12. Click the Test button to test your connection to the server. A message will display that says: "Dreamweaver
connected to your web server successfully." If it does not, try re-entering your Username and Password.

NOTE: If you receive a message about enabling Contribute, see the information below before continuing.

About Contribute Compatibility



If connecting to a site that was previously edited with Contribute, you may see an alert when you connect asking if you
want to enable Contribute compatibility. Click "No" and do not enable compatibility. Doing so can cause a bug in
Dreamweaver.

If you click "Yes" by mistake:

1. From the main menu, click Site/Manage Sites.

2. Select your website and click Edit.

3. In the left menu, select Advanced Settings/Contribute.

4. Uncheck the check box.

5. Click OK and retry connecting.

Next Steps:

Next, you need to download (get) your website files and unzip the "Templates.zip" file.

file:///C|/Users/Jason/Desktop/IRT%20Archive/setup.html
http://med.stanford.edu/irt-resources/webauthor/training/dreamweaver/


Fighting Spam
On this page...

Good news/bad news
Some basics
Not so basic
Regarding List Servers
Starting over
Stanford Email
Non-Stanford Email
Standing Up to the Spammers
Resources

Purveyors of unsolicited bulk mail buy and sell lists of email addresses and use them to send mass mailings pitching
all sorts of products and services from the mundane to the obscene. Early Netizens took to calling it "spam" because it
reminded them of the Monty Python skit where restaurant patrons choose from a menu made up exclusively of items
like "Spam, spam, spam, spam, spam, baked beans and spam" and are slowly drowned out by a rising chorus of
Vikings and other people chanting "spam, spam, spam, spam." over and over. Perhaps one day email spam will be
relegated to the dustbin of Internet history. For now though, spam appears to have joined death and taxes on the short
list of life's inevitable problems.

Good news/bad news

The bad news: Once you start getting spam, there's really no truly effective way to stop it. The best you can hope for
is to keep the flow from increasing. If you're getting more spam than real email with an account, the best bet may be to
change email addresses and be more careful with the new address.

The good news: There ARE things you can do to prevent or minimize the amount of spam you get, especially if you
start clean and are disciplined about limiting behavior that promotes spam. The same applies when you start over with
a new address.

Some basics

Spam exists because it's commercially profitable. Remove the profit motive and spam will evaporate.

Don't spam

Don't send spam yourself. If you send mass mailings, a joke or family holiday note for example, make sure to use the
BCC field in your email program so the other addresses are hidden from recipients. Chain mail with loads of CC
addresses can put these addresses in the hands of spammers.

Don't respond

Never respond to spam. Even if it says you can be removed from the list. At best you're removed from this one list. At
worst, and much more likely, you confirm to the spam artists that your email address is still valid, opening the
floodgates for more.



Delete unread spam

It's usually not difficult to determine what's spam just by looking at the From and Subject indicators, even before
opening the mail, especially if the mail is from a stranger. Subject lines will often be sexually related, offer weight loss
"miracle" drugs, or try to sell mortgage packages. With practice, you will notice which subject lines you expect from
your contacts and can select and delete spam mail without opening it.

Spam filters

Numerous services and enterprises have sprung up to address the scourge of spam. Most work on some kind of
filtering principle, i.e. recognizing spam sources and shunting possible spam away from your regular mail stream. At
this time, no one appears to have a perfect solution, but you may find one or more useful. Here are some cutting-edge
anti-spam software:

1. Spam Sifter (PC)
This software automatically blocks spam based on the subject lines of your email. You can also create custom
filters if there's something it's not catching. The registered version is $19.95.

2. Email Magician (Mac)
Spam filters for the Macintosh platform are hard to come by. This filter works with Eudora and automatically
blocks email based on subject lines and known spammer's email domains. The lists are completely customizable.
The registered version is $35.

Note: These links are provided as a convenience to the user and do not imply endorsement by IRT or Stanford.

Stanford provides directions for filtering incoming mail into different folders in your mail directory.

Here are some handy links to Google searches for junk email prevention and junk email to get you on your merry way
to finding the filter to suit your specific needs for spamlessness.

| back to top |

Not so basic

Web listings

Is your address listed on the web anywhere? This is a key source for email lists. Spammers use software robots to scan
public sites for "mailto:" links and addresses. This is a hard one, because it may be important to get your address to
people with legitimate reasons for contacting you. There are some tricks you can do with JavaScript to make your
address available but unreadable by robots. I suppose that as robots become more sophisticated, these tricks also
become fallible. When dealing with spam, the mission is to keep one step ahead of the bad guys. Perhaps Thomas
Jefferson was referring to spam (presciently) when he said, "The price of freedom is eternal vigilance."

A simple solution

One solution to this problem is to avoid listing people's contact information on your site's page, and instead linking to
the person's listing in Stanford.Who. In this way, the information is accessible, but the person can control what
information is available to the public, including email, phones, etc.

To do this, simply go to Stanford.Who and search out the info page for the person in question. Here's an example:

John Hennessy 
(link will appear in a new window)

http://www.yetos.com/
http://www.yav.com/emailmagician.html
http://www.stanford.edu/services/email/antispam/spamfilter.html
http://www.google.com/search?hl=en&lr=&ie=ISO-8859-1&q=junk%2Bemail%2Bprevention
http://www.google.com/search?hl=en&lr=&ie=ISO-8859-1&q=junk%2Bemail


Here's the URL:
http://stanfordwho.stanford.edu/lookup?search=Hennessy&key=DS883L573

Note that the link format above is for the public Stanford.Who. You can also use the same technique for internal
Stanford.Who, but should warn users that they need a SUNet ID. Like this:

John Hennessy 
(SUNet ID required; will appear in new window)

SUNet ID holders can omit contact info that shows in the public version of Stanford.Who from the public version,
although not everyone does so. What is and isn't displayed is controlled through Stanford.You (SUNet ID required).

If you have a lot of contacts to process, you may want to try a different linking technique. Use the following form for
the URL:

http://stanfordwho.stanford.edu/lookup?search=Last,+First
Example: John Hennessy (link will appear in a new window)

Make sure to verify that the person is in StanfordWho before using this techniqe and always check your results to
make sure you get the right person (many people have very similar names). Try this for example: William Smith (will
appear in new browser window).

JavaScript to the Rescue

You can use JavaScript to hide your mailto links from SpamBots*. A number of approaches have been developed,
most of which can be found in Google. Here is one approach:

A typical mailto link takes this form: Jane Crayon:
jane@crayon.net

Here's the code: <b>Jane Crayon:</b> <a
href="mailto:jane@crayon.net">jane@crayon.net</a>

The following two techniques break up an email address into chunks
that are unitelligible to most robots but are perfectly sensible to the
Web user:

Method 1:

Sample: Jane Crayon: jane@crayon.net

Code:

Simply copy the code from the box above and change the jane part
to your username and the crayon.net part to your email domain
(e.g. stanford.edu)

Method 2:



Sample: Jane Crayon: [jane at crayon dot net]

Code:

To make use of this technique, copy all the code from the text box
above and modify it to reflect the address you wish to hide, i.e.
change "ja"+"ne"+"@"+"cr"+"ay"+"on.n"+"et", in both places it
occurs in the code. So, for example, somebody@stanford.edu could
be rendered "some"+"body"="@"+"stan"+"ford.e"+"du"

* IRT only maintains top-level pages for the Stanford Medicine. If
your address is on a Web page you don't maintain yourself, and you
wish a change to your listing, you will need to contact the
maintainer of the site directly.

Newsgroups

Do you use newsgroups? Newsgroups are email lists used to communicate on any topic you can imagine. Because the
postings (and their sources) are typically open to the public, their use can be a major source of spam. If you post to
newsgroups, you may want to set up a special email account for that purpose.

Hide behind an alternate address

You sometimes have to provide an address to subscribe to a site, use its services, or to buy something online; you don't
have to give them your main address that your friends write to. It's very easy and recommended to set up a free email
account you can give to web sites with the full understanding that it will likely become a hot target for spam.

The most popular free email services are Hotmail, Yahoo! Mail, and Netscape. Also check out this Google search for
free email.

| back to top |

Regarding List Servers

Membership on mailing lists can result in spam, if the access to the list is not controlled. Check policies and practices
carefully on non-Stanford list servers.

If you have a list on the Stanford Mailman list service, be sure to restrict posting to admins for the most restrictive
posting, or to members for the least restrictive. You don't want your list to be postable by unapproved users.

| back to top |

Starting over

When you set up a new email account, try to avoid having your old account transfer email to the new address. Instead,
when you're sure the new address is working, email all your active contacts your new address and ask them to update
their address books. Set a date at which you'll stop responding to mail to your old address.



| back to top |

Stanford Email

Stanford email (recognizable by the @stanford.edu ending) offers some options for changing email addresses. Your
email options are managed through Stanford.You (SUNet ID required). In addition to your SUNet login ID (example:
jcrayon for Jane Crayon), you also get two free "aliases" (examples: jane.crayon, scribble.crayon). Leland turns these
into email addresses (examples: jcrayon@stanford.edu, jane.crayon@stanford.edu and scribble.crayon@stanford.edu).
Stanford.Who displays the information you have set as public, potentially including your email address(es).

It is very difficult to have your SUNet login ID changed once it's set. ITSS generally only does this when you change
your legal name. But you can turn the email address that uses the login ID (jcrayon@stanford.edu in our example) off
using Stanford.You. When you go through Stanford.You > Your SUNet Services Settings > Change SUNet IDs, you
will find a checkbox next to your login ID. Unchecking this box turns off email to this address. You must have at least
one alternate SUNet ID (also set on this page), and the alternate ID(s) are then new addresses you can use. If you're
already using an alternate rather than your login ID, you can use the second alternate to create a new address and
transition to it.

While you're in Stanford.You, you might want to review your privacy settings. If you don't want your email
address(es) to be public, you can make it/them private. There's also a settings page for email and web addresses.

Stanford has also installed anti-spam software on its servers. Based on the content of the message, the softwae
automatically identifies patterns that resemble spam. All of this occurs before you receive the message. When a
message is determined to be spam, the message is sent to you with the keyword "[SPAM:###...]" appended to the
beginning of the subject line. You can set up your mail program to filter such messages to a Spam folder for review
before permanent deletion. For more information go to Stanford's anti-spam email page.

| back to top |

Non-Stanford Email

For personal email address changes, contact your ISP (i.e. AOL, PacBell, Delphi, etc.). AOL for example, allows you
up to 7 "screen names," each with its own email address. And you can always make use of the free email services
mentioned to create new addresses.

Once you have a fresh address you'll probably still get the occasional spam, but if you follow the advice above, you
should be able to keep it to a manageable minimum.

| back to top |

Standing Up to the Spammers

In recent years, the spam issue has become so grave that many countries and states have passed anti-spam legislation.
If a particular spammer becomes a persistant nuisance and refuses your calls to stop sending you mail, you can bring
the case to court. Generally a stern threat of suit against a particular offender will solve the problem and save you
court fees. In California, for example, the worst offenders can be fined up to $25,000. Check out out these sites and
related articles:

Whether Anti-Spam Laws are Constitutional

| back to top |

http://www.wm.edu/law/publications/jol/articles/geissler.shtml


Resources

http://spam.abuse.net/
Coalition Against Unsolicited Commercial Email
ITSS on Spam
Junkbusters
Stop Spam FAQ
SpamLaws
California Spam Laws

http://spam.abuse.net/
http://www.cauce.org/
http://www.stanford.edu/group/itss-ccs/security/junkmail.html
http://www.junkbuster.com/
http://www.mall-net.com/spamfaq.html
http://www.spamlaws.com/
http://www.spamlaws.com/state/ca1.html


Edit Text and Apply Text Styles
You will encounter two kinds of text formatting in Dreamweaver:

1. Block-level or "native" HTML, which includes Paragraphs and Heading 1 through Heading 6, affect the entire
block of text; use the Format menu in the Properties Inspector

2. Special CSS (Cascading Style Sheets) styles can be applied to individual bits of text or whole blocks; use the
Style menu in the Properties Inspector

Step 1: Create new headlines and paragraphs

1. View the page you want to edit in a browser; Students, find your practice site home page
2. Switch to Dreamweaver, find the corresponding file from your Local Files list, get a fresh copy and open it;

Students, it's root/index.html
3. Students, update the main headline so others will know you are practicing here; Example: "[Your Name] is

Practicing Here 6/21/07"
4. Put your cursor at the beginning of the body text and create a new paragraph by typing Enter, move the cursor

up, and type in some text
5. Type Enter and type a second line of text
6. With your cursor anywhere on the first new line, drag the "Format" menu to "Heading 2"

The entire block changes
7. Move your cursor down a line and repeat, choosing Heading 3 this time
8. With the cursor still on the second line, go back to "Format" and choose "Paragraph"

The entire block changes; this is what is meant by "block-level"

Best practices:

Always have one Headline 1 headline at the top of the page

Most of the page should be normal paragraphs, broken up by Heading 2 through Heading 6 headlines and
subheadlines

Use the "native" HTML formats for most of your page text; use CSS styles sparingly

Step 2: Apply special CSS text styles

This is an example paragraph where a number of different CSS styles have been applied. Note that this paragraph is
quite ugly as a result.

1. Select some text
2. Apply a CSS style using the following menu sequence: Text > CSS Styles > [pick any style that begins "text_"]
3. Repeat for other CSS styles; try right-click (windows)/ctrl-click (mac) to find the CSS Styles menu
4. Repeat in a headline block
5. Place a cursor within or at the end of a paragraph without selecting any specific text
6. Apply a CSS style



The entire block changes; not knowing what specific text to apply the style to, Dreamweaver applies it to
the nearest tag

Know your style

The Stanford Medicine format contains many styles for different purposes. Styles that begin "text_" are intended to
style regular text. Styles that begin "link_" are for styling links. Avoid using styles that begin "Nav" as these are used
by our navigation scripts. We will discuss some of the other styles as we go along. Please review the list of Stanford
Medicine Styles by Category, and print it out for later reference.

Caution: HTML formatting and custom styles

Older Web pages may make use of the Font tag set to control text appearance. Most likely you will encounter
this type of formatting only if you work with old pages. If you encounter it, it's a good idea to clear this code
before applying styles.
Avoid using the Font and Style controls by themselves; it's best to rely on the native HTML and built-in CSS
styles formats

Good formats: OK to use:

Bold
Italic
Bulleted lists
Numbered lists
Blockquotes
Text alignments

Bad formats: Don't
ever use:

Font (i.e. Arial,
Helvetica,
sans-serif, etc.)
Size

Use with caution
only:

Text color

http://med.stanford.edu/irt-resources/webauthor/training/dreamweaver/


Troubleshooting Problems
Need to delete a file or files from the server

Right-click (Win) or Ctrl-click (Mac) the name of the file in your local files list
Select "Locate on Remote Server" from the popup menu
You should be taken to the "Remote" view of your files, with the file in question selected; be careful, these are
the live files on the server
Right-click (Win) or Ctrl-click (Mac) the name of the file in the remote files list
From the popup menu, select Edit >> Delete, then confirm and the file is deleted

To have an indexed file removed from Google and other search engines, add a new Disallow command to the
robots.txt file found at the domain root of your site. Typical syntax:

Disallow: /path/to/the_file_you_deleted.xyz

Cannot display the remote folder: An HTTP WebDAV error occurred....

This error usually indicates a problem with the WebDAV URLs connection protocol, which must be secure. Check
your WebDAV settings to make sure you have the correct WebDAV URL for the site in question, and that it begins
"https://" and not "http://"

HTTP Error 401

This is a generic connection error that occurs in WebDAV connections.

If you are using Dreamweaver MX 2004 or older, you may just have a problem with the site definition settings for
your password. You will need to re-enter your password each time you launch Dreamweaver MX 2004. See the
training page on this. We also suggest you upgrade to the latest version, 8 or newer.

If you are using Dreamweaver 8 or newer, this type of error comes up most often when there's a problem with the
LDAP cache used by WebDAV to retrieve the SUNet IDs that are allowed to edit the site. Contact Web Help to report
your 401 Error and request that the WebDAV cache be cleared.

If you are getting a 401 error under other circumstances, please report it via Web Help along with as many details as
you can provide about your situation.

HTTP Error 200

This is a newly reported error. We believe it is associated with permissions on the computer on which the site is
downloaded by Dreamweaver. Interestingly, we were able to create new files and folders through the Desktop, but
when getting the site with Dreamweaver, it was able to write the folders but not the files, in the local folder. We're
investigating and will update this item when we have more information. But it appears to be a local computer problem,
not a general connection problem.

Can't Upload a Page

WebDAV makes heavy use of the check-in/check-out function. When one user "checks out" a file, it can't be edited
by any other user, to protect everyone from inadvertent overwrites. But more often than not, this comes up because one
user checked out the file, but never checked it back in.



You may be able to overwrite the file anyway, in which case, do so. We recommend you get a fresh copy of the file
from the server first, though, to be safer.

Dreamweaver may provide you with the email address of the user who checked the file out. You can contact that user
and request that they check it back in. If this is impractical, or likely to take too long, contact Web Help to request
assistance. Specify the file or files you need to edit.

Can't See My Changes in Browser

Did you refresh/reload your browser view? If yes, go back and check both Remote and Local file views. It must show
under Remote to be live. Try a "put" using the Check In command instead of Put.

Can't Disconnect, Can't Do Anything

Under some circumstances, particularly on Macintosh computers, connecting with Contribute Compatibility turned on
can lead to being trapped in connection mode; can't stop the connection, can't disconnect, can't quit or do anything. To
escape this loop, Force Quit from Dreamweaver: Go to your Desktop and find "Force Quit" in the Apple menu. Find
Dreamweaver in the list and click "Force Quit." Edit the site definition (Site menu > Manage Sites), find the
Contribute category and uncheck "Enable Contribute compatibility." When you re-connect, be sure not to click Yes on
the Contribute compatibilty prompt.
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